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Notice

While reasonable efforts were made to ensure that the information in this document was complete

and accurate at the time of printing, Lucent Technologies can assume no responsibility for any errors

in the use of this information or for liability or damage resulting from the use of this information or

from the use of the PARTNER ACS 3.0 Remote Administration Software (�Software�). Please refer to

the Lucent Technologies Single User License Agreement furnished along with the Software for your

rights and responsibilities with respect to this Software. Your feedback is welcomed. Any changes

and/or corrections to the information contained in this document that are adopted by Lucent

Technologies will be incorporated into future issues. Check the Readme file enclosed with the

software to ensure you are aware of any last minute modifications to this documentation.

Your Responsibility for Your System�s Security

Toll fraud is the unauthorized use by any party of your telecommunications system. For example, toll

fraud includes use by persons other than your company's employees, agents, subcontractors, or

persons working on your company's behalf. Note that there may be a risk of toll fraud associated

with your telecommunications system, and if toll fraud occurs, it can result in substantial additional

charges for your telecommunications services.

You and your System Manager are responsible for the security of your system, such as programming

and configuring your equipment to prevent unauthorized use. The System Manager is also responsible

for reading all installation, instruction, and system administration documents provided with this

product in order to fully understand the features that can introduce risk of toll fraud and the steps

that can be taken to reduce that risk. Lucent Technologies does not warrant that this product is

immune from, or will prevent unauthorized use of, common carrier telecommunications services or

facilities accessed through or connected to it. Lucent Technologies will not be responsible for any

charges that result from such unauthorized use.

Trademark Notice

PARTNER is a registered trademark of Lucent Technologies.

Microsoft, Windows, and Windows NT are registered trademarks of Microsoft Corporation.

IBM is a registered trademark of International Business Machines Corporation.
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This guide is your key to PARTNER
®
ACS R3.0 Remote Administration.

Use this guide to learn:

� What the program can do

� How to install the software

� How to connect to a PARTNER system

� The basics of the administration process

� What you can do with Remote Diagnostics

� Where to find additional information

About this Guide

About t h i s Gu id e
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PARTNER
®
ACS Remote Administration gives you the ability to manage a PARTNER

Communications system from your PC. Among the many features it contains are ones

that let you:

And PARTNER Remote Administration gives you the ability to retrieve diagnostic

information from your PARTNER ACS system, allowing you to:

All these features are accessed through a graphical interface that is easy to learn and

use. And though the name says �Remote�, you can also use it to manage a PARTNER

system locally. You can even choose to work offline and activate your changes when

it�s convenient.

� Program the system (for example, assign outside lines)

� Program extensions (for example, program an autodial button on any extension)

� Back up and restore these and many other settings

� View the type of modules installed on the PARTNER system

� Retrieve reports on system events such as errors and reboots

� Identify the current version of your software

Please note these important points:

■ PARTNER Remote Administration only works with PARTNER Release 3.0 and later.

■ If you have PARTNER ACS R3.0 Remote Administration R1.0 or R1.03 on your PC, you

must uninstall it before installing this software.

■ If you have PassageWay Administration for PARTNER software on your PC, you must

uninstall it before installing this software. PARTNER Remote Administration replaces

the old software.

■ To help ensure the security of the PARTNER system, you cannot create or change the

remote administration password with this software. This must be done on the system

itself. (See page 17 for instructions on how to do this.)

What is PARTNER
®

ACS Remote Administration?

What i s PARTNER ® ACS Remo t e Admi n i s t r a t io n?
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In addition to supporting all system programming and remote administration features

already available in Release 1.0 and Release 1.03 on your PC, Release 2.0 supports the

following features and capabilities:

� Windows 98/Windows NT 4.0 Support

Release 2.0 can run on Windows 95, Windows 98, and Windows NT 4.0.

� Telephone Template Support

In previous releases of PARTNER Remote Administration, the button programming

interface provided only the PARTNER-34D telephone template. Release 2.0 provides

a button layout that more closely follows the telephones available on the target

PARTNER system. Release 2.0 provides button layouts for the following types of

telephones: PARTNER-34D, PARTNER-18D, PARTNER-18, PARTNER-6, MLS-34D,

MLS-18, MLS-12, MLS-6, and MLC-6.

� Multi-modem Configuration Support

In previous releases, PARTNER Remote Administration allowed only one modem to

be configured for dialup sessions on the host PC. Release 2.0 allows you to choose

the modem you want to use when there is more than one modem configured on

your PC.

� Print System Programming Information into a Text File

Release 2.0 provides the capability to print system programming information into a

text file. You can select the type of system information you want to print to the file

(for example, extension programming, lines, pools, general system settings, groups

and/or lists information). This text file can then be opened by any word-processing

application.

� Interface to Third-Party Label Printing Software

Release 2.0 provides the capability of launching a third-party label printing

software application as long as the label printing application supports the

importing of a button information text file generated by PARTNER Remote

Administration Release 2.0. Please refer to the Readme file in the PARTNER Remote

Administration directory for more information about third-party label printing

software applications.

NEW FEATURES IN THIS RELEASE

Installation

1

In s t a l l a t i on
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WHAT YOU NEED TO RUN PARTNER REMOTE ADMINISTRATION

On Your PC

OPERATING SYSTEM

Microsoft Windows 95, Windows 98, or Windows NT 4.0

COMPUTER HARDWARE

IBM compatible PC with a Pentium

processor (100 MHz or faster)

3.5 inch, 1.44 MB high-density

floppy disk drive

An internal or external V.34 BIS modem

(14.4 or faster)

10 MB of free disk space

Windows-compatible VGA monitor

supporting at least 16 colors and

800 x 600 pixel screen resolution

Windows-compatible pointing device

(a mouse, etc.)

16 MB of RAM

On Your PARTNER ACS System

PARTNER ACS Advanced

Communications System R3.0.

PARTNER Remote Access Card, which

functions as a modem and a

backup/restore card

PARTNER display phone

1

In s t a l l a t i on

Installation
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The PARTNER Remote Administration software includes an installation program that

copies the application onto your PC�s hard drive.

To install the software:

Start Windows.

Insert PARTNER ACS R3.0 Remote Administration for PARTNER

Disk 1 into the floppy disk drive.

Click the Start button located on the taskbar and select Run

from the menu.

The Run dialogue box appears.

Type a:\setup in the command line box and click OK.

The PARTNER ACS R3.0 Installation window appears.

You respond to a series of standard Windows installation prompts.

During the installation you can:

� Confirm or change the file directory where PARTNER Remote

Administration will be installed

� Choose to create shortcuts which will allow you to run the application by

directly clicking on a title or icon in the Start menu and/or the desktop.

The installation program copies files from the source disks to the

destination directory.

Insert the second disk when prompted.

When the software is installed successfully, you will see an Installation

Completed message.

Click on the Next button.

Your PARTNER Remote Administration software has now been

successfully installed.

Remove the floppy disks and store them in a safe place.

INSTALLING THE SOFTWARE1

In s t a l l a t i on
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If you receive an error message during the installation process, check whether:

■ PARTNER ACS R3.0 Remote Administration Release 1.0 or 1.03

software is still installed on your PC. If it is, you must uninstall this

program:

� Select Programs from the Startmenu.

� Choose PARTNER ACS R3.0 Remote Administration and select

Uninstaller for Remote Administration.

■ You have at least 10 MB of hard disk space available. If there is not:

� Free space on the designated hard drive by transferring files to another

drive or deleting them from your disk.

or

� Install PARTNER Remote Administration on another drive which has at

least 10 MB of free space.

■ You are using Windows 95, Windows 98, or Windows NT 4.0.

PARTNER Remote Administration works like most other Windows programs. To start the

program either:

■ Click on the Startmenu and select Programs / PARTNER ACS R3.0

Remote Administration / Remote Administration.

Note: This is the default location. If you choose to save your files to

an alternate location during installation, your path will be different.

■ Or, if you created a desktop short-cut, double-click on the Remote

Administration icon on the desktop.

SOLVING INSTALLATION ERRORS

STARTING PARTNER REMOTE ADMINISTRATION

1

An Overview of System Administration

I ns t a l l a t io n
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Managing your phone system using PARTNER Remote Administration involves the

following tasks:

The file you retrieve from the PARTNER system is called the System Translation. It contains

the specific line, extension, button, and other custom settings for the system. You make

changes to the translation and then send those changes back to the PARTNER system.

BASIC REMOTE ADMINISTRATION TASKS

� Starting the software (page 7)

� Connecting to the PARTNER system (page 10)

� Retrieving the system translation (page 19)

� Making changes to the information (page 21)

� Restoring (that is, activating) the system translation

on the system (page 26)

2

An Overview of System Administration

An Ov e r v iew o f Sy s t em Admi n i s t r a t io n
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In addition to making changes to the system translation, you can use PARTNER Remote

Administration to:

And while this Remote Administration software is quite powerful, it does have a few

limitations. You will not be able to program Automatic Line Selection, perform a Frigid

Start, or print a new header on a Call Reporting (or SMDR) report. Of course, these

functions can be performed locally at your PARTNER system.

ADDITIONAL CAPABILITIES

� Create a new translation (page 24)

� Administer the date and time (page 27)

� Run diagnostic reports (page 28)

PARTNER Remote Administration has extensive, context-sensitive help.

Press F1 for assistance and information on any feature or screen.

2

An Ov er v i ew of Sy s t em Adm in i s t r a t io n
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3

Connec t i ng t o t h e PARTNER ACS S ys t em

There are three methods of connecting to a PARTNER system.

OVERVIEW

Operator Assisted

Use this method when

the PARTNER system

does not have an active

Automated Attendant

system or a dedicated

line for the Remote

Access card.

Automated Attendant

Use this method when

the PARTNER system has

an Automated Attendant

system turned on.

Direct Dial

Use this method when

you have established

either of the following for

the Remote Access card:

■ An intercom extension

(Local Direct Dial)

■ A dedicated outside

line (Remote Direct Dial)

Regardless of the method you use, you will need a Remote Administration

Password before you can connect. (For information on creating a Remote

Administration Password, see page 18.)

Connecting to the PARTNER ACS System
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3

Conn ec t in g t o t he PARTNER ACS Sy s t em

You manually call the main number for the system. The operator then transfers your call

to the Remote Access card.

On the Filemenu, select Connect to PARTNER System.

Select Operator Assisted, and click Next.

From a phone connected to the same line as the PC�s modem,

dial the main number for the PARTNER system.

When the operator answers, if necessary, ask for the Remote

Administration Password.

Ask to be transferred to extension 76.

As soon as you hear the extension ring, click OK.

The extension will ring for about 10 seconds. As soon as you

hear the modem connect, hang up the phone.

When prompted, enter the Remote Administration Password

and then click OK.

OPERATOR ASSISTED

Note: If you are having difficulty completing an operator-assisted connection,

the problem may be due to a rough hand-off between the voice call and the

modem. With certain types of modems, it may be necessary to connect a

bridging adapter to your modem to facilitate the hand-off process.

A bridging adapter is a plastic jack extension. It plugs into a single jack and expands

this outlet into a two-jack outlet.

■ Plug a bridging adapter into the line jack on your modem.

■ Connect both the outside line and the phone line into

the bridging adapter.

1

2

3

5

4

6

7

8
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You connect to the Remote Access card by going through an active automated attendant

(such as a voice mail system that automatically answers and routes the call). You can use

this method after business hours or anytime the Automated Attendant is active. To use the

Automated Attendant method, you must have previously established

a Hunt Group for the PARTNER Remote Access card.

On the Filemenu, select Connect to PARTNER System.

Select Automated Attendant, and click Next.

Enter the dial string.

� phone number

� seven commas

� 7 7 and the single-digit Hunt Group number for the

Remote Access Card

Click OK.

When prompted, enter the Remote Administration Password and

then click OK.

AUTOMATED ATTENDANT

To create a Hunt Group while at a PARTNER phone:

1 From extension 10 or 11, activate System Programming by pressing Feature 0 0

2 Press the left Intercom button twice

3 Enter # 5 0 5

4 At the GROUP: prompt, enter a group number (1�6)

We recommend the number 6.

5 The following display appears

HUNT GROUP 6

EXTENSION:

6 Enter extension 7 6

(This is the pre-established extension number for your PARTNER modem.)

7 Exit programming mode by pressing Feature 0 0

■ For more information about Hunt Groups, refer to the Programming and Use manual

that comes with your PARTNER system.

■ For information about the location of special programming buttons on a PARTNER

phone, see Figure 2-3 on page 2-22 of the Programming and Use manual.

3

Connec t i ng t o t h e PARTNER ACS S ys t em
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3
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5
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3

Connec t i ng t o t he PARTNER ACS Sy s t em

You call from the same location as the PARTNER system and dial an internal extension.

On the File menu, select Connect to PARTNER System.

Select Direct Dial, and click Next.

Enter the intercom number for the Remote Access card

(extension 76) and click OK.

When prompted, enter the Remote Administration Password

and then click OK.

DIRECT DIAL (LOCAL)

In order to connect locally to the modem on the Remote Access card, you must

establish it as an intercom extension.

1 Plug the line from your PC modem into a spare extension port on your PARTNER ACS

system.

You must now program your PARTNER system to enable your PC to place

an intercom call:

2 From extension 10 or 11, activate System Programming by pressing

Feature 0 0 , System Program , System Program , Central Tel Program

3 At the Extension: prompt, enter the extension number that you connected to in Step 1

4 Press

5 Press the right Intercom button

The display will read �Automatic Line Selection�

6 Press         to exit Automatic Line Selection

7 Enter Feature 0 0 to exit programming

For information about the location of special programming buttons on a PARTNER

phone, see Figure 2-3 on page 2-22 of the Programming and Use Manual.

1

2

3

4
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You dial an outside line that is assigned to the PARTNER Remote Access card. Use this

method only if the system does not have an active voice messaging system. If the system

does have its voice messaging activated, use the Automated Attendant method.

On the Filemenu, select Connect to PARTNER System.

Select Direct Dial, and click Next.

Enter the phone number for the Remote Access card and click OK.

When prompted, enter the Remote Administration Password, and

then click OK.

DIRECT DIAL (REMOTE)

See the next page for detailed information on how to set up your PARTNER

system to accommodate the Direct Dial (Remote) method.

3

Connec t i ng t o t h e PARTNER ACS S ys t em

1
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Before you can directly call a PARTNER phone system from a remote location, you must

assign the outside line that you have dedicated to your PARTNER modem to a Hunt Group.

This will enable an outside call to bypass the receptionist and ring directly at

the PARTNER modem.

Assign the outside line to a Hunt Group.

1 From extension 10 or 11, activate System Programming by pressing

Feature 0 0 , System Program , System Program # 2 0 6

2 At the GROUP: prompt, enter a group number (1-6)

We recommend the number 6.

3 At the Line prompt, enter the line number that you will be dedicating to use for

remote access.

Now you must program the Hunt Group to ring at the modem.

4 Press # 5 0 5

5 At the GROUP: prompt, enter the number you entered in Step 2. A display similar

to the following appears:

HUNT GROUP #

EXTENSION:

6 Enter 7 6

(This is the pre-established extension number for your PARTNER modem.)

7 Press Feature 0 0 to exit programming

Now you must change the ringing options so this dedicated line does not

ring at all your phone extensions.

8 From extension 10 or 11, activate Centralized Programming by pressing

Feature 0 0 , System Program , System Program Central Tel Program

9 Enter an extension number

The green lights next to the line buttons show the current Line Ringing settings:

Immediate Ring - steady light; Delayed Ring - slow flash; No Ring - quick flutter

10 Press the line button until the button light is set to No Ring (quick flutter)

11 Repeat Steps 9 and 10 for all extensions, except 76

12 Press Feature 0 0 to exit programming

For information about the location of special programming buttons on a PARTNER

phone, see Figure 2-3 on page 2-22 of the Programming and Use manual.

3

Conn ec t in g t o t he PARTNER ACS Sy s t em
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3

Connec t i ng t o t h e PARTNER ACS S ys t em

PARTNER Remote Administration automatically recognizes your modem, identifying its

configuration as well as the port it is connected to. If you encounter problems using

your modem or have trouble connecting:

Check that the modem on your PC is working properly by dialing

into another system (such as an online service) that you know you

can connect with.

Follow the steps that you have used to successfully complete the

connection in the past.

� If the modem call is completed successfully (i.e., you achieve access

to the desired system), then you have confirmed that the modem is

working properly. However, you should also test your modem by using

the �Windows Phone Dialer,� as explained in the next bullet item.

If the modem call is not completed successfully, then the problem could

lie with the modem itself. (See #2 below.)

� You can test your modem by using the Windows Phone Dialer.

From the Start menu, select Programs, select Accessories, and then

click on Phone Dialer.

Enter any telephone number in the dialog box that appears. Click Dial.

The computer will try to dial that number. If the computer can access a

dial-tone and dial the number, you know that your modem is working

properly. (See #3 on the next page.)

Check your modem configuration in your Windows system.

� Click on the My Computer icon on your desktop, select Control Panel,

and then double-click on the Modems icon.

� A dialogue box will appear with the General tab highlighted.

� Verify that the modem information displayed corresponds to the

modem you are using.

SOLVING CONNECTION PROBLEMS

1

2
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If the modem information is incorrect, you will need to reinstall

your modem:

� From the General tab in the Modem Properties window, remove the

modem with the incorrect information. Under the Control Panel, select

Add New Hardware and follow the prompts. You should also refer to

the Installation Instructions that accompanied your modem.

� If the modem information is correct, click on Properties and make sure

that the port listed is the port your modem is actually connected to.

Check your connection rate.

If your connection to the PARTNER system is operating at less

than 9600 baud:

� Click on the My Computer icon on your desktop, select Control Panel,

and then activate the Modems application.

� Make sure that the connection rate that appears in the Maximum

Speed box is the highest rate that can be used by both your modem and

the modem at the PARTNER system.

� Make sure the box entitled Only Connect At the Speed is NOT

checked.

� Try your call again.

3

Retrieving a System Translation

Connec t i ng t o t he PARTNER ACS Sy s t em

3
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Creating a Remote Administration Password

For security purposes, the Remote Administration Password is different from the system

Password. The Remote Administration Password can only be created on the PARTNER

system and must exist before you can connect.

Using a PARTNER display phone:

1 From extension 10 or 11, activate System Programming by pressing Feature 0 0

2 Press System Program

3 Press System Program # 7 3 0

4 Enter a password up to 8 alphanumeric characters in length (there is no default pass-

word). Each character is established by entering two digits. (See the Character Code

Table (5-3) on page 5-131 of the Programming and Use manual for additional details.)

5 To save the password, press the Enter key. The display shows �Remote Password�

confirming that the password was saved. (Warning: If you exit without pressing

Enter , your new password will not be saved.)

For information about the location of special programming buttons on a PARTNER

phone, see Figure 2-3 on page 2-22 of the Programming and Use manual.

3

Connec t i ng t o t h e PARTNER ACS S ys t em
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Before you can modify your system translation, you must retrieve the current system

translation from your PARTNER system. This involves the following steps:

After connecting to the system, you must back up the system information before

making any changes.

On the Administration menu, select Retrieve System Information.

Click Remote Backup. If you want to also retrieve this system

information, click Retrieve System Translations. If you want to also

retrieve maintenance information for the PARTNER system, click

Retrieve Maintenance Data.

Click Next.

The system translation is copied to the Remote Access card on the

PARTNER system. (System translation is the technical term for the

programming information.)

A backup usually takes about fifteen seconds.

� Backing up the system information

� Transferring the system information to your PC

� Disconnecting from the PARTNER system (optional)

� Print a translation to a text file

BACK UP THE SYSTEM INFORMATION

4

Retrieving a System Translation

Re t r i ev in g a S y s t em Tr ans la t ion

1

2

3
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You make the changes to the translation on your PC, not on the system itself.

On the Administration menu, select Retrieve System Information.

Click Retrieve System Translations. If you want to retrieve the

current translations, click Remote Backup. If you want to also

retrieve maintenance information for the PARTNER system, click

Retrieve Maintenance Data.

Click Next.

Retrieving the information takes about one minute.

A dialogue box will appear. Select the file or enter a new name.

Click Save.

When the transfer is complete, a dialogue box will appear. Click OK.

After you have retrieved the file, you can disconnect and work offline. You can remain

connected if you don�t expect your changes to take long to program.

On the Filemenu, select Disconnect from PARTNER System.

A message box appears.

Click OK.

TRANSFER THE INFORMATION TO YOUR PC

DISCONNECT FROM THE PARTNER SYSTEM

c

4

R et r i ev in g a Sy s t em Tr an s l a t io n
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When you first start PARTNER Remote Administration, an untitled file will appear on your

PC�s screen. This is the workspace where you will perform all your administration actions

such as programming and editing existing translations as well as creating new translations.

The workspace contains six major windows. Within each window are additional sub-

sections where you make changes to specific functions.

You do not need to be connected to the PARTNER system to program the system. After you

have transferred system information to your PC, you can disconnect from the PARTNER

system and work off-line. If you do this, you will then need to save your changes into

another file and reconnect to restore them.

EXPLORINGTHEWORKSPACE

Making Changes to the System Translation

5

Mak in g Ch ang es t o t h e Sy s t em Tr an s la t io n
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WINDOWS FUNCTION SECTIONS/FEATURES

System Window Global settings � General Parameters

� Central Office Parameters

� Adjuncts (Accessories you may use

with the system)

� Automatic System Answer (ASA)

� Direct Extension Dial (DXD)

Lines Window Administrative procedures

for particular lines

� Dial Mode

� Hold Disconnect

� Ring Pattern

� Group Call Distribution

� Line Coverage Extensions

� Voice Mail System (VMS)

Hunt Properties

Pools Window Assign lines to or remove

lines from pools

NOTE:

The Pools window is available only when the

system is configured for Hybrid mode.

Extensions

Window

Settings for specific

extensions

� General Parameters

� Button Programming

� Personal Speed Dial List

� Restrictions

� Group Memberships

� Caller ID Information

� Auxiliary Equipment

� Copy Settings

System Groups

Window

Specify the type of

group you want to assign

to different extensions

and/or lines

� Pickup Groups

� Calling Groups

� Hunt Groups

� Night Service Group

Lists Window Set up the particular lists

and assign to particular

extensions

� Allowed Lists

� Disallowed Lists

� Emergency Numbers

� Speed Dial Numbers

� Forced Account Codes

5

Mak in g Ch anges t o t h e Sy s t em Tr an s la t io n
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Within the workspace environment, you can:

The translation automatically appears in your workspace as a read-only file when the

transfer is complete.

Make your changes.

After you have completed your changes, save the file with

a new name.

Transfer and restore the translation in the file with the new name to

your PARTNER system to activate the changes.

WORKING WITH TRANSLATIONS

� Edit a translation you have just retrieved

� Edit a translation stored on your PC

� Create a new or custom translation

The changes you make to a file do not take effect on your PARTNER system

until you transfer the information back to the PARTNER system and restore

the translation.

To edit a translation you have just retrieved

5
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On the Filemenu, select Open.

Locate the file and click Open.

Edit and save the file.

Transfer and restore the translation to your PARTNER system to

activate the changes.

If you are administering a new PARTNER system or several PARTNER systems, you can

create a translation to be used on any or all of them.

For example, a travel agency might have programming needs similar to other travel

agencies. In such cases, it could be helpful to create files that are templates for such

businesses (such as �Travel.xmg�). This template could be used as a starting point for

other travel agencies, saving you time and providing your customer with a tested and

useful profile.

Open a new workspace.

Establish the profile by making changes to the untitled workspace.

Save the changes by saving the file with a unique name.

Use this translation as a template for other systems with similar requirements.

Transfer and restore the translation to the PARTNER system(s).

To edit a translation you already saved

After making changes to a translation, be sure to save them.

To create a new translation

Each system will have to establish a Remote Administration Password. When you

restore a new translation file that you created, the Remote Administration

Password is erased. The password must be readministered at the PARTNER system.

Activating Your Changes

5
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You can print the translations to a text file that you can view and print with any word

processing software. By default, the text file is saved in the Administration subdirectory.

Open the file you want to print.

On the File menu, select Print to File.

Enter the name for the text file you want to create, and then click

Save.

Select the system translation information you want to print to the

text file.

Click OK.

If you�re having problems with a PARTNER system, you can use Remote Administration to

replace a problematic translation with a known working translation.

Select a known working translation (a file previously saved

on your PC).

Transfer it back to the PARTNER system.

Restore that translation on the system.

You can also use PARTNER Remote Administration to review system problems.

See �Remote Diagnostics� on page 28.

To print a translation to a text file

Troubleshooting translation problems

Administering Date and Time
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After you have made changes to a translation and saved the file, you can send the

changes to the PARTNER system and activate them. PARTNER Remote Administration

refers to the activation process as a �restore�.

Be sure you are connected to the PARTNER system.

� On the File menu, select Connect to PARTNER System.

On the Administration menu, select Send System Information.

Select the file you want to send and click Open.

Sending the information takes about one minute.

On the Administration menu, select Restore System Translations.

A message box appears. Activating the changes takes about fifteen

seconds.

Click OK.

After the �Restore� process is complete, you will automatically be

disconnected from the PARTNER system.

Transfer your changes to the system

Restore the changes

When you restore the translation, the PARTNER system will be out of service for

several seconds. Any calls in progress will be terminated. You may want to

restore a translation after business hours.

Activating Your Changes

Ac t i va t in g Your Ch anges
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With PARTNER Remote Administration, you can change the date and time setting on your

PARTNER system. To ensure that you do not inadvertently change these settings, this

change can only be made while you are connected to the system. The new date and time

will be activated immediately. It does not require you to restore information to the system.

To change the date and time:

Connect to the PARTNER system.

On the Administration menu, select Date and Time.

You will see your PC�s date and time settings displayed.

Click Retrieve.

The date and time of the PARTNER system will now be displayed.

Change the date or time as necessary.

Click Set.

The new date and time is sent to the PARTNER system.

Click Close.

Disconnect from the PARTNER system (optional).

You can also retrieve the system date and time at any point. For troubleshooting

purposes, you may need to check this information, but you may not wish to make a

change. In this case, follow Steps 1 through 3.

Administering Date and Time

Adm in i s t e r in g Dat e and T ime
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You can retrieve important information about the PARTNER system. After connecting:

On the Administration menu, select Retrieve System Information.

Click Retrieve Maintenance Data. If you want to view the retrieved

maintenance data, click View Maintenance Data After Retrieval.

Click Next.

Enter a new filename and click Save to save the file.

The system retrieves the information. If you selected View Maintenance

Data After Retrieval, the Remote Diagnostics program launches, showing

you:

� An inventory of the system components

� A record of system events

� A record of system errors

If you did not select View Maintenance Data After Retrieval, select Remote

Diagnostics from the Tools menu to launch the Remote Diagnostics

program. Select the Diagnostics file you want to view.

Note: You can print a report of either your system events or system errors by

clicking the printer icon on the toolbar.

Remote Diagnostics

1
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4

R emo t e Di ag no s t i c s
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� PARTNER Remote Administration contains an integrated Help file that

can provide you with detailed information on all of the program�s

features. Press F1 for context-sensitive help.

� For more documentation on PARTNER administration, you can refer to

the PARTNER ACS R3.0 Programming and Use manual.

� For additional technical support, you can contact your local Authorized

Dealer or you can call Lucent Technical Support at 1 800 628-2888.

In the continental U.S., Lucent Technologies provides a toll-free customer

hotline 24 hours a day. Consultation charges may apply.

Where to Get More Information

Wher e t o Ge t Mo r e In f o rmat ion
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How Are We Doing?

We welcome your comments. They will help us serve you better in the future.

PARTNER ACS R3.0 Remote Administration R2.0 Getting Started Guide, Issue Number 1,

Publication Date June 1999, #518-456-166, Comcode 108520123

Please check the ways you feel we could improve this document

Improve the overview

Improve the table of contents

Improve the organization

Include more illustrations

Add more examples

Add more detail

Make it more concise

Add more step-by-step procedures

Make it less technical

Add more/better quick reference aides

Please check the ways you feel we could improve the software

Add more features

Improve the user interface

Provide "wizards" to assist with the complicated tasks

Simplify the programming tasks

Did you experience any problems with

Installing the software

Using the basic features

Connecting to your system

Programming changes

Activating changes

Other suggestions for improvement: ________________________________________________

______________________________________________________________________________

May we contact you about your comments? If so, please complete the following:

Name _________________________________________________________________________

Company _____________________________________________________________________

Address ______________________________________________________________________

City ____________________________________________________ State _______________

Zip ___________________________________ e-mail ________________________________

Please photocopy, complete, and return this form to:

Publications Manager

Lucent Technologies, Rm. #2W-226

211 Mt. Airy Road.

Basking Ridge, NJ 07920

Fax: 908-953-6912
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